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1. Manual Information

This Windows Driver Installation Manual provides information on installation, detailed
specifications, and usage of the printer’s Windows Driver according to PC operating
system (OS).

We at BIXOLON maintain ongoing efforts to enhance and upgrade the functions and
quality of all our products. In following, product specifications and/or user manual content
may be changed without prior notice.

2. Operating System (OS) Environment
The following operating systems are supported for usage.

Microsoft® Windows XP SP3 (32bit)

Microsoft® Windows XP SP1 or later (64bit)

Microsoft Windows Server 2003 SP1 or later (32bit/64bit)
Microsoft Windows VISTA (32bit/64bit)

Microsoft Windows Server 2008 (32bit/64bit)

Microsoft Windows Server 2008R2 (64bit)

Microsoft Windows 7 (32bit/64bit)

Microsoft Windows 8 (32bit/64bit)

Microsoft Windows Server 2012 (64bit)

Microsoft Windows 10 (32bit/64bit)

* Serial and Parallel printer port do not work on Windows 10 version 1511 (OS Build
105860.104) specific. We recommend you to install the latest Windows 10 update
through Windows Update before installing Windows Driver.

You can download and install the Windows Update in the Update & security tab of the
Settings menu (58 > Settings > Update & security > Windows Update).

3. Windows Driver Preparation

The Windows Driver is included in the enclosed CD, and the latest file version can be
downloaded from BIXOLON website. (www.bixolon.com)

Rev. 1.02 -3-



4. Windows Driver Installation

4-1 Installing on Windows XP / Server 2003

4-1-1 Via Serial Port or Parallel Port

1) Double-click the Windows Driver installation file.

2) Click Next.

BIXOLON SRP-275111 Windows Driver Installation

Welcome to the InstallShield Wizard for BIXOLON SRP-275111 Windows Driver

InstallShieid

[ ok [ G

M your compuker. To

Cancel

SRP-275Ill

3) Select a COM or LPT port to be used, and then click Next.

Rev. 1.02

Port Type

Serial Port
® CoML
) COM2
O ComM3

USE Port
O Usk

Parallel Port
OLPT1 O LPTZ

Ethernet
) Ethernet
IP Address @
Port Mumber :

O coM4
O COMS
) COME

O COM7
O COMB
() COMB

) COM10
) CcoM11
) COM12

|192.1aa. 1

3

O COM1E
O COM17
O CcoM1g
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4) Click Yes to reboot the PC.

€, Restarting your computer can kake effect,
\__-/ Please restart wour computer,

[es] I want to restart my computer now.
[Mo] T will restart my computer later,

Yes Mo

5) Open the printer properties window in the Windows OS.
% Control Panel — Printers and Faxes.

6) In the Ports tab, click Configure Port.
%  SKip this step if you selected a LPT port.

7) Match the communication settings to those of the printer. The communication settings of
the printer can be performed by conducting a self-test.
% Skip this step if you selected a LPT port.

COM1 Properties

Fort Setlings |
Bitz per second: | 19200 W |
Data bits: |E v|
PBarity: |Nn:|r'|e v|
Stop bits: | 1 » |
Elawe contral: |N|:|ne V|
[ Bestore Defaults ]
[ ok [ Cancel ] [ Apply ]

Rev. 1.02 -5-
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8) Click Print Test Page and check printing status. Proper installation of the driver is
indicated if the test page is printed normally.

& BIXOLON SRP-2751| Properties

General |Sharing Portz || Advanced | Color Management || Verzion

@
@ |E=I><EILEIN SRP-2751 |

Location: | |

Carmment:

b odel: Bl<0OLOM SRP-275I

Features

Colar: Yes FPaper available;
Double-sided: Mo 7B = 3276 mm[275I1]
Staple: Mo

Speed: Unknown

b axirnuim rezolution: 160 dpi

Frinting Preferences...] [ Print Test Page |

k. ] [ Cancel Apply

Rev. 1.02 -6 -
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4-1-2 Via USB Port
1) Double-click the Windows Driver installation file.

2) Click Next.

BIXOLON SRP-275111 Windows Driver Installation

Welcome to the InstallShield Wizard for BIXOLON SRP-275111 Windows Driver

o will imstall 7SI Windows Driver on your camputer, To

InstallGhieid . I_ < Back H i Cancel
3) Select USB and then click Next.
BPort Type |g|

Serial Port
Oy comMml O CoM4 O COM7T CycomMio O CcoMi1z O CoMle

OcoMz  QcoMs  QcoMs O CoMil O coMid (O COM1T
OcoMs  OcoMe OcoMs O coMiz O coMis (O CoM1g

LISE Port

Parallel Port
OLPT1 O LPTZ

Ethernet
) Ethernet

IP address ; | 192 . 1682 . 1 . 1 |

Port MNumber ;

Rev. 1.02 -7-
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4) Click OK.
X

- | ) Please turm-off the printer and then turn-on again.

Ik

5) Turn off the printer and then turn it on. The printer driver will be installed automatically.

6) Open the printer properties window in the Windows OS.
% Control Panel — Printers and Faxes.

7) Click Print Test Page and check printing status. Proper installation of the driver is
indicated if the test page is printed normally.

H BIXOLON SRP-2 7511l Properties

General |Sharing Portz | Advanced | Color Management | Version

jRL
fod  [BIOLON SRP278IN |

Location: | |

Comment;

tModel: Bl<0LOM SRP-275I

Features

Calar: Yes Paper available:
Double-zsided: Mo ¥E =% 3276 mm[275I1]
Staple: Ma

Speed: Unknown

b amirnum resolution: 160 dpi

Printing F'referen-:es...] | Frint T st Page |

] ] [ Cancel

Rev. 1.02 -8-
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4-1-3 Via Ethernet Port
1) Double-click the Windows Driver installation file.

2) Click Next.

BIXOLON SRP-275111 Windows Driver Installation

Welcome to the InstallShield Wizard for BIXOLON SRP-275111 Windows Driver

o will imstall 7SI Windows Driver on your camputer, To

InstaliShieid , Caricel
3) Select Ethernet.
4) Enter the IP address and port number, and then click Next.
Port Type |E|
Serial Port

OcoMl  OcoMd  OCoM? O coMio O coMiz O CoMIA
OcoMz  QcoMs  QcoMs O CoMil O coMid (O COM1T
OcoMs  OcoMe OcoMs O coMiz O coMis (O CoM1g

USE Port
O Usk

Parallel Port
OLPT1 O LPTZ

Ethernet

IP address ; | 192 . 168 . 1 . 1 |

Port MNumber ;

Rev. 1.02 -9-
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5) Click Yes to reboot the PC.

€p |  Restarting your computer can take effect,
\_t,) Please restart your computer,

[es] I want to restart my computer now,
[Mo] T will restart my computer laker,

Yes Mo

6) Open the printer properties window in the Windows OS.
% Control Panel — Printers and Faxes.

7) In the Ports tab, click Configure Port....

8) Match the communication settings to those of the printer.
¥ The “LPR” protocol is not supported with this printer.

Configure Standard TCP/IP Port Monitor

Fort Setlings |

Port Mame: | IP_192.1681.1 |

Frinter Mame or IF Address: | 132165811 |

Pratacal

) Raw QO LFR

R aw Settings
Part Murnber: | 00 |

LFPR Settings

LPR Buyte Counting Enabled

[ ] SMMP Status Enabled

[ Ok |[ Cancel ]

Rev. 1.02 -10 -
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9) Click Print Test Page and check printing status. Proper installation of the driver is
indicated if the test page is printed normally.

& BIXOLON SRP-2751| Properties

General |Sharing Portz || Advanced | Color Management || Verzion

@
@ |E=I><EILEIN SRP-2751 |

Location: | |

Carmment:

b odel: Bl<0OLOM SRP-275I

Features

Colar: Yes FPaper available;
Double-sided: Mo 7B = 3276 mm[275I1]
Staple: Mo

Speed: Unknown

b axirnuim rezolution: 160 dpi

Frinting Preferences...] [ Print Test Page |

k. ] [ Cancel Apply

Rev. 1.02 -11 -



4-2 Installing on Windows VISTA / Server 2008 /7 / 8 / Server 2012/ 10

4-2-1 Via Serial Port or Parallel Port

1) Double-click the Windows

2) Click Next.

Driver installation file.

SRP-275Ill

BIXOLOM SRP-275IIl Windows Driver Installation

Welcome to the InstallShield Wizard for BIXOLON SRP- 275111 Windows Driver

The InstallShield Wizard will install BIXOLON SRP-275II1 Windows Driver on your computer. To

continue, did: Next.

InstallShield l < Back H ] Cancel
3) Select a COM or LPT port to be used, and then click Next.
Port Type >
Serial Port
Jcom4a (com7 (O COM1o () COM13 () COM1G
Ccoms O coms (Ocomll  (comia () Ccomiz
Ccome (come (comlz () Ccomls () Comis
USB Port
D use
Parallel Port
QT QLPT2
Ethernet
() Ethernet
IP Address : | 192 . 168 . 1 . 1
Port Number : 9100
MNext

Rev. 1.02
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4) Click Yes to reboot the PC.

Restarting your computer can take effect.
Please restart your computer.

[¥es] | want to restart my computer now.
[Me] | will restart ry computer later.

Yes Mo

5) Open the printer properties window in the Windows OS.
3 Control Panel — Hardware and Sound — Device and Printers.

6) In the Ports tab, click Configure Port.
% Skip this step if you selected a LPT port.

7) Match the communication settings to those of the printer. The communication settings of
the printer can be performed by conducting a self-test.
% Skip this step if you selected a LPT port.

COM1 Properties ? >
Port Settings
Bits per second: | 15200 '
Data bits: | 8 e
Parity: | Mone w
Stop bits: | 1 e
Flow control: | Hardware e
Bestore Defaults
Cancel Apply

Rev. 1.02 -13 -
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8) Click Print Test Page and check printing status. Proper installation of the driver is
indicated if the test page is printed normally.

Rev. 1.02

I@ BIXOLOM SRP-275IIl Properties

General Sharng Ports  Advanced Color Management  Securty  Version

-L% BIXOLOM SRP-27511

Location:

Comment:

Model: BIXOLOM SRP-27511

Features
Color Yes

Double-sided: Mo
Staple: Mo
Speed: Unknown

Maxirmum resclution: 160 dpi

Paper available:

T x 3276 mm[275111]

Preferences...

OK

Print Test Page

Cancel Apphy

-14 -
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4-2-2 Via USB Port

1) Double-click the Windows Driver installation file.

2) Click Next.

BIXOLOM SRP-275IIl Windows Driver Installation

Welcome to the InstallShield Wizard for BIXOLON SRP- 275111 Windows Driver

The InstallShield Wizard will install BIXOLON SRP-275II1 Windows Driver on your computer. To
continue, dick Next.

| <o ]|

InstalShield

3) Select USB and then click Next.

Port Type

Serial Port
Ocomi O coma (OcoMm7 (JCcoMio (O CcoMiz () COMIG
Ocomz  Ocoms (Ocoms  (JcoMil  (comia () COM17
(D) Ccom3 () COMa O come Ocomiz O coMmis (O CoMis

USB Port
®]

Parallel Port
O LPT1 O LPTZ

Ethernet

(O Ethernet
IP Address : | 192 188 . 1 . 1
Port Number : 9100

Mext

Rev. 1.02 -15-



4) Click OK.

o Please turn-off the printer and then turn-cn again.

oK

SRP-275Ill

5) Turn off the printer and then turn it on. The printer driver will be installed automatically.

6) Open the printer properties window in the Windows OS.

% Control Panel — Hardware and Sound — Device and Printers.

7) Click Print Test Page and check printing status. Proper installation of the driver is
indicated if the test page is printed normally.

Rev. 1.02

@ BIXOLOM SRP-275lll Properties

General Sharng Pois  Advanced Color Management  Securty  Version

-L% BIXOLOM SRP-27511

Location:

Comment:

Model: BIXOLOM SRP-27511

Features

Color Yes Paper available:

Double-sided: Mo TBx 3276 mm[275111]

Staple: Mo
Speed: Unknown

Maximurm resclution: 160 dpi

Preferences...

oK

Print Test Page

Cancel Apphy

-16 -
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4-2-3 Via Ethernet Port

1) Double-click the Windows Driver installation file.

2) Click Next.

BIXOLOM SRP-275IIl Windows Driver Installation

Welcome to the InstallShield Wizard for BIXOLON SRP- 275111 Windows Driver

The InstallShield Wizard will install BIXOLON SRP-275II1 Windows Driver on your computer. To
continue, dick Next.

< Back H

InstalShield

3) Select Ethernet.

4) Enter the IP address and port number, and then click Next.

Port Type

Serial Port
OcoMl (Ocomd4 (O coM7 (O COM10 () COM1Z () COM1G
Ocom2  (coms (O coms (O comil (O comia (O COM17
() com3 i) COMa (O come iocomMiz O comis (O CcoMis

USB Port
O use

Parallel Port
O wpT1 OLPT2

Ethernet

IP Address | 192 . 168 . 1 . 1

Port Number :

Mext

Rev. 1.02 -17 -



5) Click Yes to reboot the PC.

Restarting your computer can take effect.
Please restart your computer.

[¥es] | want to restart my computer now.
[Me] | will restart ry computer later.

Yes Mo

6) Open the printer properties window in the Windows OS.

3 Control Panel — Hardware and Sound — Device and Printers.

7) In the Ports tab, click Configure Port....

8) Match the communication settings to those of the printer.

¥ The “LPR” protocol is not supported with this printer.

Configure Standard TCP/IP Port Monitor

Port Settings

Port Name: | IP_192.168.1.1

Printer Mame or IP Address: | 182.168.1.1

Protocol

Faw Settings

®) Raw OLPR

Part Mumber; G100

LPR. Settings

LPR Byte Counting Enabled

[C]5MMP Status Enabled

public

1

Cancel

Rev. 1.02 -18 -
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9) Click Print Test Page and check printing status. Proper installation of the driver is
indicated if the test page is printed normally.

Rev. 1.02

I@ BIXOLOM SRP-275IIl Properties

General Sharng Ports  Advanced Color Management  Securty  Version

-L% BIXOLOM SRP-27511

Location:

Comment:

Model: BIXOLOM SRP-27511

Features
Color Yes

Double-sided: Mo
Staple: Mo
Speed: Unknown

Maxirmum resclution: 160 dpi

Paper available:

T x 3276 mm[275111]

Preferences...

OK

Print Test Page

Cancel Apphy

-19 -



5. Windows Driver Settings

The following functions can be configured after installing the Windows driver.

5-1 Paper

Paper  Document Settings

1) Open the Printer Properties window for the corresponding OS.

2) In the General tab, click Preferences (Printing Preferences).

3) Click the Paper tab.

Rev. 1.02

Paper
Paper Size : VB % 3276 mm

Paper Type Receipt

Mumber of copies

Copies 3 [1.755]

Color

(®) Color

) Monochrome

Orientatian
(®) Portrait

() Landscape

-20 -
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5-1-1 Paper Size
Paper size of 76 x 3276 mm is selected by default, and the following sizes can be selected.

7611 297 mm 7613276 mm

If a custom paper size is required, click “...” to add or update a custom paper size. Click
Save after specifying the paper width/length and a paper name. If the specified paper
name already exists on the system, you can update the paper width/length.

Paper Width  : 25.4 mm (Min) ~ 76.0 mm (Max)
Paper Length : 25.4 mm (Min) ~ 3276.0 mm (Max)

User Defined Faper Size *

FPaper Size

MewPapersize Delete

Paper Mame : |NewF‘aperSize || Save |

Paper width ; S mm [ 25.4-76.0]

Paper Length : 32760 s mrn [ 25.4 - 3276.0]

Cloze

You can choose the new paper size on the Paper Size combo-box after adding a paper
size.

Paper  Document Settings

FPaper
Paper Size HewPaperSize w
VB = 3276 mm
Paper Type: |76 » 237 mm |
Delete button : Deletes the paper size selected in the list.
Save button . Adds a new paper size or update the paper size selected in the list if

the paper name already exists on the system.

Rev. 1.02 -21-
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5-1-2 Paper Type
You can choose Receipt or Ticket as paper types. Receipt allows flexible paper length
according to the data length. Ticket print in fixed length even the print data is short. The

default setting is Receipt.

Receipt : Receipt allows flexible paper length according to the data length.
Ticket . Ticket print in fixed length even the print data is short.

Paper  Document Settings

Paper
Paper Size VB = 2276 mm w
Paper Type : Receipt w

Ticket

MHumber of copie

Copies 3 [1.7255]

Colar

{®) Color
() Monachrome

Orientation
(®) Portrait
() Landscape

Rev. 1.02 -22 -
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5-1-3 Copies
Copies are printed by specifying the copy count. The copy count is set to 1 by default. Set
this value bigger than 1 to set the number of copies to print. The value should be within the
range of 1 to 255.
5-1-4 Color
The printer can print by using black and red, or by using black only. Select Monochrome if
you want to use black color only.

5-1-5 Orientation

Printing orientation can be set to Portrait (which is the default) or Landscape. It is not
possible to use printer fonts (device fonts) in landscape.

Portrait : Printing in the vertical direction.
Landscape : Printing in the horizontal direction.

Rev. 1.02 -23-



5-2 Document Settings

1) Open the Printer Properties window for the corresponding OS.

2) In the General tab, click Preferences (Printing Preferences).

Paper Document Settings

Send Command

Start Do

Start Page :

|
|
End Page : |
End Doc |

Example ; <TBA400% ar <1BxJ<00:

Cash Drawer

[ ] Open before printing #1
[] Open befare printing #2
[ ] Open after printing #1
[]Open after printing #2

Line Feed

Line-feeds after printing :

FPaper Cut

[0 ]C (0. 3]

() Page /Job : Mo Cut / Mo Cut

(®)Page /Job : Mo Cut / Partial Cuk

50
50
50
50

() Page /Job : Partial Cut / Partial Cut

3) Click the Document Settings tab.

Rev. 1.02
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5-2-1 Send Commands

The Windows driver serves to receive the content for print from an application and send it
to the printer. The Send Commands function allows for the addition of desired commands
at the start or end of the print content.

Start Doc : Addition of command at the beginning of the document.
Start Page :  Addition of command at the beginning of the page.

End Page :  Addition of command at the end of the page.

End Doc :  Addition of command at the end of the document.

For more information about the hexadecimals that can be entered in “Start Doc”, “Start
Page”, “End Page” and “End Doc”, refer to the Commands Manual.

5-2-2 Cash Drawer

To open a cash-drawer before printing, tick “Open before printing #1” or “Open before
printing #2” in the “Cash Drawer” and then click “OK”.

To open a cash-drawer after printing, tick “Open after printing #1” or “Open after printing
#2” in the “Cash Drawer” and then click “OK”.

5-2-3 Line Feed

Enter the number between 0 and 99 for adding blank lines at the end of printing.

5-2-4 Paper Cut

Paper can be cut at the end of each page or each document (job).

Page/Job : No Cut / No Cut . Paper is not cut after printing.
Page/Job : No Cut / Partial Cut . Paper is cut at the end of each document (Job).
Page/Job : Partial Cut / Partial Cut . Paper is cut at the end of each page.

Rev. 1.02 -25 -



6. Windows Driver Specifications

6-1 Printer fonts

SRP-275Ill

This Windows driver supports various printer fonts (device fonts) in the following table.
Printing using these fonts is faster than using Windows fonts provided by the operating

system.

Standard Printer Fonts

Printer Fonts Size (Dot) Size (Point)
FontAlx1 FontA1x1[Ext.] FontA1x1[255] FontA1x1(9x9) 9
FontA1x2 FontA1x2[Ext.] FontA1x2[255] FontA1x2(9x18) 18
FontA2x1 FontA2x1[Ext.] FontA2x1[255] FontA2x1(18x9) 9
FontA2x2 FontA2x2[Ext.] FontA2x2[255] FontA2x2(18x18) 18
FontB1x1 FontB1x1[Ext.] FontB1x1[255] FontB1x1(7x9) 9
FontB1x2 FontB1x2[Ext.] FontB1x2[255] FontB1x2(7x18) 18
FontB2x1 FontB2x1[Ext.] FontB2x1[255] FontB2x1(14x9) 9
FontB2x2 FontB2x2[Ext.] FontB2x2[255] FontB2x2(14x18) 18

Printer Fonts for Korean and Chinese

Printer Fonts Size (Dot) Size (Point)
Koreanlxl Koreanl1x1 (17x9) 16
Koreanl1x2 Koreanl1x2 (17x18) 32
Korean2x1 Korean2x1 (34x9) 16
Korean2x2 Korean2x2 (34x18) 32
Chinese2312_1x1 Chinese2312_1x1(16x16) 16
Chinese2312_1x2 Chinese2312_1x2(16x32) 32
Chinese2312_2x1 Chinese2312_1x1(32x16) 16
Chinese2312_2x2 Chinese2312_1x2(32x32) 32
ChineseBIG5_1x1 ChineseBIG5_1x1(16x16) 16
ChineseBIG5_1x2 ChineseBIG5_1x2(16x32) 32
ChineseBIG5_2x1 ChineseBIG5_1x1(32x16) 16
ChineseBIG5_2x2 ChineseBIG5_1x2(32x32) 32

Rev. 1.02
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Printer Fonts are defined as follows.

1) FontA1x2
- ANSI Character code support (Code Page 1252)
- Character size (dot): 9 x 18 (double height)
- Character size (point): 18

2) FontA1x2[Ext.]
- IBM expansion Character code support (Code Page 437)
- Character size (dot): 9 x 18 (double height)
- Character size (point): 18

3) FontA1x2[255]
- Buyer exclusive code supports
- Character size (dot): 9 x 18 (double height)
- Character size (point): 18

Rev. 1.02 -27 -
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6-2 Special Functions
This Windows driver supports the special functions as shown in the following table.

Select the FontControl font first and use the characters in the table to use the special
functions. Take care as this function is not for printing general texts.

Character Special Function

HT (0 x 09) is output

LF (0 x OA) is output

CR (0 x OD) is output

Open Cash drawer 2 (50ms drive pulse width)

Open Cash drawer 2 (100ms drive pulse width)

Open Cash drawer 2 (150ms drive pulse width)

Open Cash drawer 2 (200ms drive pulse width)

Open Cash drawer 2 (250ms drive pulse width)

Open Cash drawer 2 (50ms drive pulse width) without feeding

Cut without paper feeding

Align text to the left

Align text to the center

Align text to the right

Open Cash drawer 1 (50ms drive pulse width)

Open Cash drawer 1 (100ms drive pulse width)

Open Cash drawer 1 (150ms drive pulse width)

Open Cash drawer 1 (200ms drive pulse width)

Open Cash drawer 1 (250ms drive pulse width)

Open Cash drawer 1 (50ms drive pulse width) without feeding

Prints the NV bitmap image saved in the 00 address

Prints the NV bitmap image saved in the 01 address

Prints the NV bitmap image saved in the 02 address

Prints the NV bitmap image saved in the 03 address

Prints the NV bitmap image saved in the 04 address

TR« |[—|ZT|IOMM[O|IO|T > [X|S Q|| |a|o || (N]|o|uv

Cut (partial cut)

1) Sample Use
If the FontControl font is selected and 6 is entered, the LF (Line Feeding) operation is
activated. (This does not entail the printing of the character “6”.)

2) FontControl Font Function

Printer Font for

Special Function Function Size (Point/Dot)

Justification (Left/Center/Right)
FontControl Output HT, Output LF, Output CR (9/9%x9)
NV bitmap printing
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7. Use of Windows Driver

7-1 Use of Visual Basic

This section contains example codes to control the printer using Windows driver with
Visual Basic. Sample programs are included in the CD.

7-1-1 Windows Driver Selection

The following code is an example of the selection of the “BIXOLON SRP-275I11” Windows
Driver.

For Each prnPrinter In Printers

If prnPrinter.DeviceName = “BIXOLON SRP-275III” Then

Set Printer = prnPrinter
Exit For
End If

Next

7-1-2 Text Printing

The following example code explains how to print texts using Windows fonts and printer
fonts (device fonts).

‘Print in Windows font
Printer.FontSize = 9
Printer.FontName = “Arial”
Printer.Print “Arial Test”

‘Print in printer font
Printer.FontSize = 9
Printer.FontName = “FontAl1x1”
Printer.Print “FontA1x1Test”

Printer.EndDoc
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7-2 Use of WordPad
7-2-1 WordPad Environment Settings

Launch WordPad, set the printing related options as follows, and test the printer with
WordPad.

- Select printer
Select “Print” from the “File” menu, and select the printer (BIXOLON SRP-275IlI).

- Set paper size, orientation, margin, etc.
Select the “Page Setting” from “File” menu, and set paper size, orientation, and margin.

7-2-2 Text Printing

Print the text from WordPad using the Windows driver of the printer.

File Edit Wiew Insert Format Help
e Ed & # @ B
|Fu:unt.ﬁ.'|:-:1 v| |E| v| |'W'estern v B S U 8 |§|§ = =
AL L -
Fontdlxl Test
For Help, press F1 FLIM

1) Select the desired font from the Font menu (FontAlx1).
2) Select the desired font size (9).
3) Enter the text to be printed in WordPad.

4) Click the Print button in the toolbar to print.
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